CHAPTER 9

Interface Status

This chapter describes how to view status information for each of the interfaces on the Cisco device
being managed using the Cisco 12000 Manager (C12kM) application.

This chapter contains the following information:
» Interfaces and Related Technol ogy-Specific Windows
» Launching the Interface Status Windows
« Generic Interface Status
e ATM Interface Status
- DSS3/ES Interface Status
- SONET Interface Status
» SRP Interface Status
- SRP Side IPS Status
« SRP Topology Map

Interfaces and Related Technology-Specific Windows

Interfaces on line cards can support multiple technol ogies. Status windows are technol ogy-specific. For
example, a DS-3 interface supports two technologies: Generic and DS-3. Therefore, if you wish to view
the status of aDS-3 interface, you must view two windows: the Generic I nterface Status window and the
DS-3 Interface Status window.

This processis also applicable to ATM, Ethernet, POS or SRP interfaces. The following table outlines
which technology-specific status windows apply to each interface type.

Table 9-1 Interface Types and Status Windows

Interface Type Technology-Specific Status Window
DS-3 Generic, and DS-3

ATM Generic, ATM, and SONET
Ethernet Generic

POS Generic, and SONET

SRP Generic and SRP

SRP Side SRP Side and SONET
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M Launching the Interface Status Windows

Launching the Interface Status Windows

Table 9-2 displays the Interface Status windows that can be launched from each object type. For
example, the Generic Interface Status window can be launched from a Site, Shelf, Chassis, Module, or
Generic Interface object only.

Table 9-2  Launching the Interface Status Windows

Objects (that can be selected) to Open the
Window/Task Site |Shelf |Chassis |Module |Interface Menu Options to Select to Open Window
Generic Interface  |Yes |Yes |Yes Yes Generic C12kM Management>Physical >Interface>Generic>
Status Interface only |Status
ATM Interface Yes |Yes |Yes Yes ATM Interface |C12kM Management>Physical>Interface>ATM>
Status only Status
DS3/E3 Interface  |Yes |Yes |Yes Yes DS3 Interface |C12kM Management>Physical>Interface>DS3>
Status only Status
SONET Interface |Yes |Yes |Yes Yes SONET C12kM Management>Physical>Interface>SONET>
Status Interface only | Status
SRP Interface Yes |Yes |Yes Yes SRP Interface | C12kM Management>Physical>Interface>SRP>
Status only Status
SRP Side IPS Yes |Yes |Yes Yes SRP Side C12kM Management>Physical >Interface>SRP>
Status Interface only |Side>IPS Status
SRP Topology Map |Yes |Yes |Yes No SRP Interface | C12kM Management>Physical>Interface>SRP>

only Topology

~

Note

The Status windows cannot be opened when multiple objects are selected (the menu options to open
the Status windows are grayed out). Available menu options can be launched from a site object
containing the required objects, when required.

Generic Interface Status

The Generic Interface Status section covers the following areas:
« Viewing the Generic Interface Status Window
» Generic Interface Status Window—Detailed Description

Viewing the Generic Interface Status Window

Step 1

To view the Generic Interface Status window for any type of interface, proceed as follows:

Right click (on arelevant object icon in the Map Viewer window or from an object pick list) and select
the C12kM M anagement>Physical>I nterface>Generic>Statusoption. Refer to Table 9-2 on page 9-2
for information on which objects allow you to launch the Interface Status window.

J_ Cisco 12000 Manager User Guide
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Step 2

The Interface Status window appears with the Status tab displayed:

Generic Interface Status

Figure 9-1 GSR Interface Status Window
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Choose a Chassis, Module, and I nterface from the lists displayed at the left of the window.

Generic Interface Status Window—Detailed Description

Interface Detalils

The Generic Interface Status tab has three areas. Interface Details, Last Change Details, and

Transmission Details.

The Interface Details area displays the following fields:

Type—Type of interface.

Description—Information about the interface. Generally contains the product name and the version of

the interface hardware or software.

Operational Status—Current operational status of the interface. Possible values are as follows:

- Up—Ready to pass packets (if admin statusis changed to up, then operational status should change
to up if the interface is ready to transmit and receive network traffic)

» Down—If admin status is down, then operational status should

be down
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Bl ATM Interface Status

» Testing—In test mode, no operational packets can be passed

» Unknown—Status can not be determined for some reason

- Dormant—Interface is waiting for external actions

« NotPresent—Some component is missing, typically hardware
» LowerLayerDown—Down due to state of lower layer interface

Physical Address—Interface's address at its protocol sub-layer. For example, an 802.x interface
normally containsa MAC address. For interfaces that do not have such an address (such asaserial line),
this object should contain an octet string of zero length.

Keep Alive—Displays whether keepalives are enabled or not on this interface.
Line Protocol—Displays whether the line protocol is up or not.

Connector Present—If the interface sublayer has a physical connector, this object has the value true.
Otherwise, this value will be false.

Last Change Details

The Last Change Details area displays the following fields:

Current State Duration—T his value indicates the time duration since the last interface operational status
was changed. This, however, is not applicable to the SRP interface side objects and the VLAN
sub-interface objects.

Reason for Last Change—Reason for the interface’s last status change.

Transmission Details

The Transmission Details area displays the following fields:
Speed—(in bps) Estimate of the interface’s current bandwidth in bits per second.
High Speed—Estimate of the interface’'s current bandwidth in gigabits per second.

Maximum Transmission Unit—Size of the largest packet which can be sent or received on the interface,
specified in octets.

ATM Interface Status

The ATM Interface Status section covers the following areas:
- Viewing the ATM Interface Status Window
» ATM Interface Status Window—Detailed Description

Cisco 12000 Manager User Guide
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ATM Interface Status

Viewing the ATM Interface Status Window

To view the ATM interface status window for any type of interface, proceed as follows:

Stepl  Right click (on arelevant object icon in the Map Viewer window or from an object pick list) and select
the C12kM Management>Physical>I nterface>AT M >Status option. Refer to Table 9-2 on page 9-2
for information on which objects allow you to launch the ATM Interface Status window. The ATM
Interface Status window appears with the Status tab displayed:

Figure 9-2  ATM Interface Status Window

ATM Interface Status

G005

Not applicable to C12kM

Step2  Choose a Chassis, Module, and ATM Interface from the lists displayed at the left of the window.

Cisco 12000 Manager User Guide
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ATM Interface Status Window—Detailed Description

The Status tab displays five areas: ATM Transmit Status, ATM Receive Status, Physical Layer Status,
ATM Port Status, and Action.

ATM Transmit Status

The ATM Transmit Status areais not applicable to C12kM.

ATM Receive Status

The ATM Receive Status area is not applicable to C12kM.

Physical Layer Status

ATM Port Status

Action

The Physical Layer Status area contains the following fields:

Physical Interface Status—Not applicable to C12kM.

Clock Source Status—Not applicable to C12kM.

Physical Port Type—Type of physical layer medium on this interface.

The ATM Port Status area contains the following fields:

Number of VPCs—Not applicable to C12kM.

Admin Address—Not applicable to C12kM.

Number of VCCs—Number of PVCs and SVCs at this interface.
ATM Address Type—Not applicable to C12kM.

Number of PVCs—Not applicable to C12kM.

NSAP (Network Service Access Point) Address—NSAP address of the interface.
Number of PVPs—Not applicable to C12kM.

Configured VP Interface—Not applicable to C12kM.

Number of PCs—Not applicable to C12kM.

SVC Minimum VCl—Not applicable to C12kM.

Number of SCs— Not applicable to C12kM.

Active SVPs—Not applicable to C12kM.

Total Connections—Not applicable to C12kM.

Active SVCs—Not applicable to C12kM.

The Action area displays a single Show Connections button. When you choose the Show Connections
button an Action report window appears displaying 10S information regarding the status of the
connections on the selected interface.

Cisco 12000 Manager User Guide
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DS3/E3 Interface Status

The DS3/E3 Interface Status section covers the following areas:
- Viewing the DS3/E3 Interface Status Window
- DS3/E3 Interface Status Window—Detailed Description

Viewing the DS3/E3 Interface Status Window

To view the DS3/E3 Interface Status window, proceed as follows:

Stepl  Right click (on arelevant object icon in the Map Viewer window or from an object pick list) and select
the C12kM Management>Physical>| nterface>DS3> Statusoption. Refer to Table 9-2 on page 9-2 for
information on which objects allow you to launch the DS3/E3 Interface Status window.

Cisco 12000 Manager User Guide
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M DS3/E3 Interface Status

The DS3/E3 Interface Status window appears with the Status tab displayed:

Figure 9-3 DS3/E3 Interface Status Window

DS3/E3 Interface Status

GO0ES

Step2  Choose a Chassis, Module, and DS3/E3 I nterface from the lists displayed at the left of the window.

DS3/E3 Interface Status Window—Detailed Description

The DS3/E3 Interface Status window has a single Status tab.

Status Tab

The Status tab displays two areas: DS3/E3 Status, and Far End DS3/E3 Status.

Cisco 12000 Manager User Guide
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DS3/E3 Status

The DS3/E3 Status area displays the following fields:
Send Code—Type of code that is being sent across the DS-3 interface by the device.
Valid Intervals—Number of previous near end intervals for which data was collected.

Time Elapsed—Number of seconds that have elapsed after the beginning of the near end current error
measurement period started.

Line Coding—Zero code suppression used in this interface.

No Error—No alarms/errors are present in the interface and the traffic signal is colored green.
Loss of Signal—Presence or absence of signal lossin the line.

Loss of Frame—Presence or absence of frame lossin the line.

Loopback State—Indicates whether the received signals are looped or not.

Rx Remote Alarm Indication—Indicates whether remote alarm signal is being received or not.
Rx Alarm Indicate Signal—Indicates whether alarm signal is being received or not.

Rx Test Code—Indicates whether the line is receiving a test pattern or not.

Tx Remote Alarm Index—Indicates whether remote alarm signal is being transmitted or not.
Tx Alarm Indicate Signal—Indicates whether alarm signal is being transmitted or not.

Far End DS3/E3 Status

The Far End DS3/E3 Status area displays the following fields:
Facility ID Code—Code that identifies a specific far end DS-3 path.

Location ID Code—Far end location identification code that describes the specific location of the
equipment.

Unit Code—Far end code that identifies the equipment location within a bay.

Valid Intervals—Number of previous far end interval for which valid data was collected.

Time Elapsed—Time elapsed after the current far end measurement period started.

Equip Code—Far end equipment identification code that describes the specific piece of equipment.

Cisco 12000 Manager User Guide
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SONET Interface Status

The SONET Interface Status section covers the following areas:
« Viewing the SONET Interface Status Window
« SONET Status Window—Detailed Description

Viewing the SONET Interface Status Window

To view the SONET Interface Status window, proceed as follows:

Stepl  Right click (on arelevant object icon in the Map Viewer window or from an object pick list) and select
the C12kM M anagement>Physical>I nterface>SONET >Statusoption. Refer to Table 9-2 on page 9-2
for information on which objects allow you to launch the SONET Interface Status window. The SONET
Interface Status window appears with the Medium tab displayed:

Figure 9-4 SONET Interface Status—Medium Tab

SONET Inte
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SONET Interface Status

Step2  Choose a Chassis, Module, and SONET Interface from the list boxes displayed at the |eft of the
window. The details for the selected interface appear.

Step3  Choose the Section tab, if required (see Figure 9-5 on page 9-11):

Figure 9-5 SONET Interface Status—Section Tab
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Step4  Choose the Line tab, if required (see Figure 9-6):

Figure 9-6  SONET Interface Status—Line Tab
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SONET Interface Status

Step5  Choose the Path tab, if required (see Figure 9-7):

Figure 9-7 SONET Interface Status—Path Tab
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Note  The Virtual Tributary tab is not applicable to C12kM.

SONET Status Window—Detailed Description

The Sonet Status Window displays five tabs: Medium, Section, Line, Path, and Virtual Tributary (not
applicable to C12kM).

Medium

The Medium tab (see Figure 9-4 on page 9-10) displays the following fields:
Type—Displays if the signal used across this interface is SONET or SDH.

Cisco 12000 Manager User Guide
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W SRP Interface Status

Section

Line

Path

Virtual Tributary

Line Coding—Type of line coding used in the interface. Can be B3ZS for electrical SONET signals or
NRZ for optical SONET signals.

Line Type—Line type for the interface. Can be short range single mode, long range single mode, or
multi-mode for fiber interfaces; for electrical interfaces, it can be coax or UTP; and for all other line
types it will be other.

Valid Intervals—Number of previous intervals for which valid data is stored.

Time Elapsed—Time elapsed (in seconds) after the start of the current error-measurement period.
Includes partial seconds.

Circuit ID—Transmission vendor's circuit identifier.

The Section tab (see Figure 9-5 on page 9-11) displays the following fields:
Loss of Signal—Presence or absence of signal loss in the SONET section.
Loss of Frame—Presence or absence of frame loss in the SONET section.
No Defect—Presence or absence of section defects.

The Line tab (see Figure 9-6 on page 9-12) displays the following fields:
Alarm Indication Signal—Presence or absence of alarm signals in the SONET line.
Remote Defect Indication—Presence or absence of remote defects in the SONET line.

No Defect—Presence or absence of line defects.

The Path tab (see Figure 9-7 on page 9-13) displays the following fields:

Signal Label Mismatch—Presence or absence of signal label mismatch in the SONET path.
STS - Alarm Indication Signal—Presence or absence of alarm signal in the SONET path.
STS - Remote Defect Indication—Presence or absence of remote defects in the SONET path.
STS - Loss of Pointer—Presence or absence of pointer lossin the SONET path.
Unequipped—Presence or absence of path equipment errors.

No Defect—Presence or absence of path defects.

The Virtual Tributary tab is not applicable to C12kM.

SRP Interface Status

The SRP Interface Status section covers the following:
- Viewing the SRP Interface Status Attributes

Cisco 12000 Manager User Guide
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Viewing the SRP Interface Status Attributes

Step 1

Step 2

» SRP Interface Status Window - Detailed Description

To view the SRP Interface Status window, proceed as follows:

SRP Interface Status 1l

Right click (on arelevant object icon on the Map viewer window or from an object pick list) and select
the C12kM M anagement>Physical>I nter face>SRP>Status option. Refer to Table 9-2 on page 9-2 for
information on which objects allow you to launch the SRP Interface Status window. The SRP Interface
Status window appears with the Status Tab displayed.

Figure 9-8 SRP Interface Status Window
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Choose a Chassis, Module and SRP Interface from the list boxes displayed on the | eft side of the

window.
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SRP Interface Status Window - Detailed Description

Status Tab

The SRP Interface Status window displays the Status tab.

MAC Address - Displays the node MAC address

MAC Passthrough - Displaysthe status of the MAC Passthrough. If set, the path for the datais available
even if the node is not operational.

Total Nodes On the Ring - Displays the total number of nodes on the ring
Prioirity Threshold - Displays the incoming packet priority limit

IPS Wait To Restore Timer - Displaysthe time interval (in seconds) to remain in the wrap state, after the
cause of the wrap is removed.

IPS Lock - Displays the status of the IPS lock (The status of the lock can be on or off)
Side A Wrap Status - Displays the status of the Side A Wrap. Is set to true, if Side A wraps.
Side BWrap Status - Displays the status of the Side B Wrap. Is set to true, if Side B wraps.

Side A Misconnection - Displaystrue, if the Side A of the Interface at the current node is not connected
to the Side B of the Interface at the remote host.

Side B Misconnection - Displaystrue, if Side B of the Interface at the current node is not connected to
the Side A of the Interface at the remote host.

~

Note  In case of a misconnection at a node (assuming to be the current node), if both the sides of
an interface are incorrectly connected then the problem is at the current node. However, if
one side of an interface isincorrectly connected then the problem is at the remote node
connecting to the respective side of the interface.

SRP Side IPS Status

The Side IPS Status section covers the following:
« Viewing the IPS Status Attributes
« |IPS Status Window - Detailed Description

Viewing the IPS Status Attributes

Step 1

This dialog displays the Intelligent Protection Switching (IPS) status of the selected interface side. To
view the IPS Status window, proceed as follows:

Right click (on arelevant object icon on the Map viewer window or from an object pick list) and select
the C12kM M anagement>Physical>I nter face>SRP>Side>| PS Status option. Refer to Table 9-2 on
page 9-2 for information on which objects allow you to launch the IPS Status window.

J_ Cisco 12000 Manager User Guide
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SRP Side IPS Status W

Figure 9-9 IPS Status Window
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Step2  Choose a Chassis, Module, SRP Interface and SRP Side from the list boxes displayed on the left side
of the window.

IPS Status Window - Detailed Description

The IPS Status window displays two frames: | PS Status and Remote Node.

IPS Status

Side Wrap Status - Displays the wrap status of the Sides at the node

IPS Wrap Counter - Displays the number of transitions from unwrap to wrap state
Neighbor MAC Address - Displays the neighbor’s MAC address on the ring

IPS Management Request Mode - Displays the current IPS management mode on the side

~

Note  The mode can be set to noRequest, manual Switch, or forcedSwitch

Cisco 12000 Manager User Guide
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M SRP Topology Map

Remote Node

IPS Active Mode - Displays the currently active IPS mode for the local hode
IPS Auto Detect Mode - Displays the current |PS mode that is automatically detected by the local node

I PS Remote Mode - Displaysthe IPS mode indicated in the | PS messages that are received from the other
nodes on the ring

IPS Remote Type - Displays the type of the IPS Remote mode.
Last Wrap Time - Displays the time (in seconds) for the last wrap
Last Unwrap Time - Displays the time (in seconds) for the last unwrap

Host Name - Displays the name of the remote host
IP Address - Displays the |P address of the remote host
Interface - Displays the Interface at the remote host

Connecting Side - Displays the connecting Side at the remote node

SRP Topology Map

The SRP Topology Map covers the following areas:
- Viewing the SRP Topology Map
» SRP Topology Map- Detailed Description

Viewing the SRP Topology Map

Step 1

To view the SRP Topology map, proceed as follows:

Right click (on arelevant object icon on the Map viewer window or from an object pick list) and select
the C12kM M anagement>Physical>I nter face>SRP>Topology option. Refer to Table 9-2 on page 9-2
for information on which objects allow you to launch the SRP Topology Map.

Cisco 12000 Manager User Guide
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Figure 9-10 SRP Topology Map
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Step2  Choose a Chassis, Module and SRP Interface from the list boxes displayed on the |eft side of the
window. The topology details of the selected SRP interface appears in the table on the right side of the
window.

SRP Topology Map - Detailed Description

The SRP Topology Map window displays the Topology Map frame.

Topology Map

Hops - Displays either 0 or a positive integer. This value determines the number of hops the next node
is away from the current node, around the ring, in the clock wise direction.

Remote Node MAC Address - Displays the 48-bit MAC address of the remote node.
Wrap Status - Displays the I PS status of the remote node.

Name - Displays the name of the remote node.

Cisco 12000 Manager User Guide
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